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In this article, we’ve compiled a variety of simple business plan templates, all of which are free to download in PDF, Word, and Excel formats.
On this page, you’ll find a one-page business plan template , a simple business plan for startups , a small-business plan template , a business plan outline , and more. We also include a business plan sample and the main components of a business plan to help get you started.

Simple Business Plan Template

Download Simple Business Plan Template
This simple business plan template lays out each element of a traditional business plan to assist you as you build your own, and it provides space to add financing information for startups seeking funding. You can use and customize this simple business plan template to fit the needs for organizations of any size.
One-Page Business Plan Template

Download One-Page Business Plan Template
Excel | Word | PDF  | Smartsheet
Use this one-page business plan to document your key ideas in an organized manner. The template can help you create a high-level view of your business plan, and it provides easy scannability for stakeholders. You can use this one-page plan as a reference to build a more detailed blueprint for your business. 
For additional single page plans, take a look at " One-Page Business Plan Templates with a Quick How-To Guide ."
Simple Fill-in-the-Blank Business Plan Template

Download Simple Fill-in-the-Blank Business Plan Template
Use this fill-in-the-blank business plan template to guide you as you build your business plan. Each section comes pre-filled with sample content, with space to add customized verbiage relevant to your product or service.
For additional free, downloadable resources, visit " Free Fill-In-the-Blank Business Plan Templates ."
Simple Business Plan for Startup

 Download Startup Business Plan Template — Word
This business plan template is designed with a startup business in mind and contains the essential elements needed to convey key product or service details to investors and stakeholders. Keep all your information organized with this template, which provides space to include an executive summary, a company overview, competitive analysis, a marketing strategy, financial data, and more. For additional resources, visit " Free Startup Business Plan Templates and Examples ."
Simple Small-Business Plan Template

Download Simple Small-Business Plan Template
This template walks you through each component of a small-business plan, including the company background, the introduction of the management team, market analysis, product or service offerings, a financial plan, and more. This template also comes with a built-in table of contents to keep your plan in order, and it can be customized to fit your requirements.
Lean Business Plan Template

Download Lean Business Plan Template
This lean business plan template is a stripped-down version of a traditional business plan that provides only the most essential aspects. Briefly outline your company and industry overview, along with the problem you are solving, as well as your unique value proposition, target market, and key performance metrics. There is also room to list out a timeline of key activities.
Simple Business Plan Outline Template

Download Simple Business Plan Outline Template
Word  | PDF
Use this simple business plan outline as a basis to create your own business plan. This template contains 11 sections, including a title page and a table of contents, which details what each section should cover in a traditional business plan. Simplify or expand this outline to create the foundation for a business plan that fits your business needs.
Simple Business Planning Template with Timeline

Download Simple Business Planning Template with Timeline
Excel | Smartsheet
This template doubles as a project plan and timeline to track progress as you develop your business plan. This business planning template enables you to break down your work into phases and provides room to add key tasks and dates for each activity. Easily fill in the cells according to the start and end dates to create a visual timeline, as well as to ensure your plan stays on track.
Simple Business Plan Rubric Template

Download Simple Business Plan Rubric
Excel | Word | PDF | Smartsheet
Once you complete your business plan, use this business plan rubric template to assess and score each component of your plan. This rubric helps you identify elements of your plan that meet or exceed requirements and pinpoint areas where you need to improve or further elaborate. This template is an invaluable tool to ensure your business plan clearly defines your goals, objectives, and plan of action in order to gain buy-in from potential investors, stakeholders, and partners.
Basic Business Plan Sample

Download Basic Business Plan Sample
This business plan sample serves as an example of a basic business plan that contains all the traditional components. The sample provides a model of what a business plan might look like for a fictional food truck business. Reference this sample as you develop your own business plan.
For additional resources to help support your business planning efforts, check out “ Free Strategic Planning Templates .”
Main Components of a Business Plan
The elements you include in your business plan will depend on your product or service offerings, as well as the size and needs of your business. 
Below are the components of a standard business plan and details you should include in each section:
	Company name and contact information
	Website address
	The name of the company or individual viewing the presentation
	Table of Contents
	Company background and purpose
	Mission and vision statement
	Management team introduction
	Core product and service offerings
	Target customers and segments
	Marketing plan
	Competitive analysis
	Unique value proposition
	Financial plan (and requirements, if applicable)
	Business and industry overview
	Historical timeline of your business
	Offerings and the problem they solve
	Current alternatives
	Competitive advantage
	Market size
	Target market segment(s)
	Projected volume and value of sales compared to competitors
	Differentiation from competitors
	Pricing strategy
	Marketing channels
	Promotional plan
	Distribution methods
	Legal structure of your business
	Names of founders, owners, advisors, etc.
	Management team’s roles, relevant experience, and compensation plan
	Staffing requirements and training plans
	Physical location(s) of your business
	Additional physical requirements (e.g., warehouse, specialized equipment, facilities, etc.)
	Production workflow
	Raw materials and sourcing methods
	Projected income statement
	Projected cash flow statement
	Projected balance sheet
	Break-even analysis
	Charts and graphs
	Market research and competitive analysis
	Information about your industry
	Information about your offerings
	Samples of marketing materials
	Other supporting materials

Tips for Creating a Business Plan
It’s easy to feel overwhelmed at the thought of putting together a business plan. Below, you’ll find top tips to help simplify the process as you develop your own plan. 
	Use a business plan template (you can choose from the variety above), or refer to the previous section to create a standard outline for your plan.
	Modify your outline to reflect the requirements of your specific business. If you use a standard business plan outline, remove sections that aren’t relevant to you or aren’t necessary to run your business.
	Gather all the information you currently have about your business first, and then use that information to fill out each section in your plan outline.
	Use your resources and conduct additional research to fill in the remaining gaps. (Note: It isn’t necessary to fill out your plan in order, but the executive summary needs to be completed last, as it summarizes the key points in your plan.)
	Ensure your plan clearly communicates the relationship between your marketing, sales, and financial objectives.
	Provide details in your plan that illustrate your strategic plan of action, looking forward three to five years.
	Revisit your plan regularly as strategies and objectives evolve.
	What product or service are we offering?
	Who is the product or service for?
	What problem does our product or service offering solve?
	How will we get the product or service to our target customers?
	Why is our product or service better than the alternatives?
	How can we outperform our competitors?
	What is our unique value proposition?
	When will things get done, and who is responsible for doing them?
	If you need to obtain funding, how will you use the funding?
	When are payments due, and when do payments come in?
	What is the ultimate purpose of your business?
	When do you expect to be profitable?

To identify which type of business plan you should write, and for more helpful tips, take a look at our guide to writing a simple business plan .
Benefits of Using a Business Plan Template
Creating a business plan can be very time-consuming, especially if you aren’t sure where to begin. Finding the right template for your business needs can be beneficial for a variety of reasons. 
Using a business plan template — instead of creating your plan from scratch — can benefit you in the following ways:
	Enables you to immediately write down your thoughts and ideas in an organized manner
	Provides structure to help outline your plan
	Saves time and valuable resources
	Helps ensure you don’t miss essential details

Limitations of a Business Plan Template
A business plan template can be convenient, but it has its drawbacks — especially if you use a template that doesn’t fit the specific needs of your business.
Below are some limitations of using a business plan template:
	Each business is unique and needs a business plan that reflects that. A template may not fit your needs.
	A template may restrict collaboration with other team members on different aspects of the plan’s development (sales, marketing, and accounting teams).
	Multiple files containing different versions of the plan may be stored in more than one place.
	You still have to manually create charts and graphs to add to the plan to support your strategy.
	Updates to the plan, spreadsheets, and supporting documents have to be made in multiple places (all documents may not update in real time as changes are made).

Improve Your Business Plan with Real-Time Work Management in Smartsheet
Empower your people to go above and beyond with a flexible platform designed to match the needs of your team — and adapt as those needs change. 
The Smartsheet platform makes it easy to plan, capture, manage, and report on work from anywhere, helping your team be more effective and get more done. Report on key metrics and get real-time visibility into work as it happens with roll-up reports, dashboards, and automated workflows built to keep your team connected and informed. 
When teams have clarity into the work getting done, there’s no telling how much more they can accomplish in the same amount of time.  Try Smartsheet for free, today.
Discover why over 90% of Fortune 100 companies trust Smartsheet to get work done.
Access our library of 130 Business Templates
Wow you’ve unlocked access to our library of 130 business templates.
Get started by checking out some of our top business templates:
Featured business templates

Weekly Schedule Template
Tracking employees’ work time and wages is easy with this free weekly schedule template.

Monthly Report
Provide a professional, concise summary of project activities with this monthly report template.

One Page Business Plan Template
This one-page business plan template will help you outline the most important details about your new...
6 Free Business Plans | PDF Templates & Examples
All business plans | pdf business templates..
Showing 1 - 6 of 6

Business Case Template

Executive Summary Template

Simple Business Plan Template

Startup Business Plan Template

Strategic Planning
Explore template collections.

Customer Service

Spreadsheets

Get all Business Plans | PDF templates and more.
	Product Overview
	Create documents
	Sign documents securely
	Track & Monitor documents
	Collaborate
	Store & Organize
	Quote, Sell & Pay
	PandaDoc VS
	eSignatures
	All use cases
	Enterprise Scale
	Teams and Departments
	Individuals
	Customer stories
	Explore all content
	PandaDoc Q&A
	Help center
	Developer center
	HubSpot CRM
	All integrations
	Sales integrations
	CRM integrations
	Payment integrations

Business plan templates
From competitive analysis to financial projections, business plans give your new business a roadmap for success. Download one of our free business plan templates and take your company to the next level.

Big Data Startup Business Plan Template
Create a professional Big Data Startup business plan with our customizable Startup Business Plan Template.

Virtual Assistant Business Plan
Strategize your way to success with this customizable AI virtual assistant business plan template.

Virtual Reality (VR) Business Plan
Our free virtual reality (VR) business plan helps you customize your document and create a winning strategy to land investors.
Get unlimited eSignatures
Create, manage, and eSign documents for only $19 per month.
No credit card required

Laundromat Business Plan
Create your success roadmap with a laundromat business plan template, designed to arrange the essentials of the laundry business.

5-Year Business Plan Template
Empower your path to long-term success with our 5-year business plan template.

Car Wash Business Plan Template
Launch and grow your car wash business with our customizable plan template.

Airbnb Business Plan Template
Unlock your path to success with our Airbnb business plan template, made to guide you in structuring the fundamental aspects of your Airbnb business.

Clothing Line Business Plan
Use this free and customizable clothing line business plan to appeal to investors and set up your fashion brand.

Gym Business Plan Template 
The Panda tips in this gym business plan template guide you through the process of researching and presenting information necessary to secure funding and partners for your business.

Handyman Business Plan Template
Start a new handyman business using a well-researched handyman business plan template to meet your goals faster.

Vending Machine Business Plan Template
If you’re starting a new vending machine business, a well-rounded vending machine business plan can improve your chances of success.

Bar Business Plan Template
Create your path to success with our bar business plan template, designed as a valuable tool to help entrepreneurs organize the bar business.

Massage Therapy Business Plan
This massage therapy business plan template helps you cover the basics of starting or expanding a massage business.

Bed and Breakfast Business Plan Template
Use a complete bed and breakfast business plan template to set up your business for growth and success.

Catering Business Plan
Chart your path to success with our catering business plan template designed to help entrepreneurs organize their catering business.

Event Venue Business Plan Template
Launch and grow your event venue with our customizable business plan template.

Event Planning Business Plan 
Prepare your event planning business for success with our ready-to-fill and easily downloadable event planning business plan template.

Rental Property Business Plan
Develop a rental property business plan tailored to serve as a valuable resource for entrepreneurs to organize their rental business.

Coaching Business Plan Template
If you want to grow your new or existing coaching business, use our free coaching business plan template as a roadmap to success.

Lawn Care Business Plan
Use a comprehensive lawn care business plan template that includes guidance and all critical information.

T-shirt Business Plan Template 
Craft a winning T-shirt business plan in a structured business format that attracts investors and funding.

Candle-Making Business Plan Template
Use a candle-making business plan template to get together all of the information you need to ensure that your candle business succeeds.

SBA Business Plan Template
Use our free and fully customizable SBA business plan template to get started when writing a successful proposal for an SBA loan.

Cleaning Business Plan Template
Discover a hassle-free way to document a roadmap for your cleaning business with this free business plan template.

Real Estate Business Plan Template
Start off your new real estate business on the right foot by using a real estate business plan template to ensure your goals, visions, and finances are sorted.

Trucking Business Plan Template
Empower your journey to success with our trucking business plan template, designed as a valuable tool to organize the essentials of your trucking business.

Food Truck Business Plan Template
Find a fully customizable, free food truck business plan template that helps you create an effective proposal for interested investors.

Simple Business Plan Template
This simple business plan template walks you through the stages of establishing a successful business or seeking funding.

Solar Farm Business Plan
Give your solar farm business the best start by creating a professional business plan to keep your company on the right track.

Ecommerce Business Plan Template
This Ecommerce Business Plan Template is tailored particularly to e-commerce companies, and all you require to do is add the elements related to your business.

Accounting Firm Business Plan
Use this Accounting Firm Business Plan to achieve your goals. Accounting firms are comparable to other industries and need the Business Plan to help their development.

Campground Business Plan Template
This PandaDoc Campground Business Plan Template has all the essential information to help you develop a successful business strategy.

Firewood Business Plan
This Firewood Business Plan Template perfectly outlines the company structure of a probable firewood venture. It highlights the budgets needed to start and manage the unique business.

Funeral Home Business Plan
A Funeral Home Business Plan covers detailed data on the courtesies offered by the company, market analysis, administration strategies, personnel procedures, budget and financing plans, and other applicable topics.

Community Center Business Plan
You can use this Community Center Business Plan Template, it is perfect for anyone desiring to open and run a society center. It gives the center’s owner an outline of areas that must be disseminated with the investors to earn an acquisition.

Gas Station Business Plan
Take the first step towards success in the fuel industry with our professionally crafted Gas Station Business Plan template.

Beauty Supply Store Business Plan
This Beauty Supply Store Business Plan Template covers all the appropriate sections needed to invest in a beauty supply store. The template will help you to raise money for your business.

Flower Shop Business Plan Template
The Flower Shop Business Plan Template is organized to help you achieve the awareness of various investors to invest in your company.

Electrical Contractor Business Plan
This Electrical Contractor Business Plan template include information about the services you offer, who your target consumers are, why they should prefer you over your opponents and how much capital you require to get started.

Car Dealership Business Plan
A Car Dealership Business Plan is a detailed plan that will help you take your business to the next level. Use this template to create your plan.

Farm Business Plan
Farm Business Plan gives an overview of the company, including corporation history, owner backgrounds, creations and more. Use this template to quickly develop your farm company plan.

Consultant Business Plan Template
An example of a document outlining your strategy for launching or expanding your consulting firm is a Consultant Business Plan Template. The essential elements include a summary of the company, team, sector, rivals, target audience, and an operations and marketing strategy.

Construction Company Business Plan
The objectives and tactics of a construction company are described in a business plan for a construction company. For the creation of your business plan, use this Construction Company Business Plan Template.

Fashion Business Plan Template
Structural and action plans for a fashion firm are laid out in the fashion business plan template.

Daycare Business Plan
The creation of a business strategy is the first step in starting a daycare. Use this Daycare Business Plan Template to describe your company’s objectives, as well as your target market, potential rivals, and your financing strategy.

Convenience Store Business Plan
Do you need a Convenience Store Business Plan Template? This plan includes all the details and information needed to secure funding for a convenience store.

Startup Business Plan Template
We offer you the steps and the tools to create a fantastic business plan. Attract investors with this sleek and free startup business plan template.

Business Plan Template
This business plan template is a great tool for your startup to customize to reflect your strong qualifications, experienced team, and marketable business idea.
What is a business plan?
A business plan is a document that helps small business owners determine the viability of their business idea. Combining market research and financial analysis, a professional business plan helps startup CEOs and potential investors determine if the company can compete in the target market.
Typically, a good business plan consists of the following:
	Executive summary
	Company description
	Mission statement
	Product and services
	Marketing plan
	Operations plan
	Management organization
	Financial plan
	Conclusion & appendix

Every section involved in a business plan is designed to help startup businesses reach their target market.
A business plan asks founders and entrepreneurs to detail their business strategy in a step-by-step process that makes sense from an operational perspective. This is essential if a startup is seeking a business loan or an investment from a venture capital firm.
However, even small businesses that are already economically viable can benefit from creating a business plan, since it encourages business owners and their management teams to examine their business model and reevaluate the best ways to reach their target customers.
Should I use a business plan template?
Yes.  If you’ve never written one, a business plan can be challenging to write.
Creating a successful plan that you can use to grow your small business can require weeks of market analysis and financial preparation. You may spend time using Microsoft Excel or Powerpoint in order to create documentation which better supports our operational decisions.
However, almost every professional business plan is structured in the same way and most ask for the same information. Because of this, using a business plan template is advisable to save time, money, and effort.
Business plan templates for free
Rather than spending time trying to figure out how to write a business plan , use a free template as a guide to completion.
Business plan templates from PandaDoc can help you reach an effective go-to-market strategy even faster by asking you to provide all the relevant information you need when creating an effective business plan.
Grab a free template to get started!
Frequently asked questions
How many pages should my business plan be.
This depends on the kind of business plan you need to write and how you intend to use the plan that you create.
For example, a plan for a small business seeking potential investors or a business loan will need to provide income statements, cash flow statements, and a balance sheet (usually for a three-year or five-year forecast period).
These financial statements can be omitted if a small business owner isn’t seeking funding and is instead planning to use their business plan as a guiding document for themselves and their management team members.
Some business plans may only run a few pages. Fully-developed business plans can be as long as 50 pages. Much of this depends on the type of business, the operational strategy, and the level of detail that goes into developing the business plan.
Who needs a business plan?
Every business should have a business plan. This is an essential guidance document for any founder or CEO.
Good business plans help a company determine the viability of its place in the market and can help the business develop better strategies for differentiating itself from its competitors.
Business planning also forces business owners to evaluate their marketing strategy, the cost of customer acquisition and retention, and how they plan to grow their business over time.
What is the best business plan template?
Business plans come in all shapes and sizes. The best business plan template for your business is one that you understand and that matches the size and legal structure of your operation.
If you’re a sole proprietor, a business plan template designed for a big corporation probably doesn’t make sense. However, a business plan that helps you build an effective roadmap to grow your business while protecting your intellectual property is a good starting point.
PandaDoc offers specialized business plan templates for common industries along with tips to help you get started with business planning.
Should I hire someone to write my business plan for me?
No. You’ll find freelance writers and business strategy companies out there who are happy to write your business plan for a fee.  These resources can guide you through the process, but you should write (or be heavily involved in) the creation of your business plan.
The reason for this is simple: You know the most about your business, and your business needs you to succeed.
A writer can work with you to make your business plan sound better to investors, and a consultant can help you fill in knowledge gaps — like how to conduct a SWOT analysis — and point out weaknesses in your plan. But, at the end of the day, you need to use the business plan to pitch investors and run your business.
Those ideas and guiding principles aren’t something you can outsource.
Should I use business planning software?
Software isn’t required when creating an effective business plan. Most business planning software is designed to help you navigate the outlining and writing process more effectively.
You don’t need software to write a professional business plan, but a solid template can help you get started. Download a free template from PandaDoc today and take your business to the next level.
Get started with PandaDoc today
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14 Professional Business Plan Samples [Downloadable pdf]
Looking for business plan examples for inspiration? Download or view 14 business plans examples/samples, vetted by our MBA business plan writers. Download in PDF format or read like a book. These real business plan samples would help in writing your own business plan.

	View Real Business Plan Examples/Samples


As an entrepreneur, effectively pitching your idea to attract investors and secure funding can be a challenge. Moreover, when launching a business, creating a comprehensive business plan is paramount.
To aid you in these crucial tasks, we offer a collection of real-world and sample business plan examples across diverse industries. A well-structured business plan is indispensable in the fast-paced entrepreneurial landscape, as it delineates your goals, strategies, and financial projections, providing a clear roadmap for your venture.
Our aim is to facilitate the creation of an effective business plan by integrating real-life examples to elucidate the key elements involved. Below, you’ll find a range of 14 detailed business plan examples available for download and use.
Important Sections to Include in Business Plan
1. e-commerce plan sample or example, 2. online marketplace business plan example or sample, 3. snack bar business plan sample / business plan example, 4. coffee shop business plan sample/business plan example pdf, 5. food hall business plan sample/business plan example pdf, 6. printing shop business plan sample/business plan example plan, 7. acquisition business plan sample/ example pdf, 8. l-1 visa business plan example with sample pdf, 9. e-2 visa business plan sample/ example pdf, 10. eb-5 business plan sample/ example pdf, 11. investor business plan sample/ example pdf, 12. nonprofit business plan sample/ example pdf, 13. bank business plan sample/ example pdf, 14. cannabis business plan sample/ example pdf, detailed overview of key components of a business plan, tips for writing executive summary, tips for writing company description, tips for writing market analysis, tips for writing product and services, tips for writing marketing and sales plan, tips for writing operational planning, tips for writing organization and management summary, tips for writing financial plan, tips for writing key external drivers, tips for writing startup summary, tips for writing projected industry growth, tips for writing break-even analysis, tips for writing management summary, tips for writing financial indicators, discover business plan formats and free templates, business plan examples for students pdf, 1. one page business plan, 2. start-up business plan, 3. strategic business plan, 4. feasibility business plan, 5. internal business plan, conclusion, download pack of 14 business plan examples, are you looking for top business plan writer.
To create a robust business plan, ensure inclusion of the following key sections:
	Executive Summary: A brief snapshot of your business and the key highlights of your business plan. Read more
	Product and Services: An elaborate description of the offerings you will provide to your customers. Read more
	Marketing and Sales Plan: A strategic roadmap outlining how you intend to promote and market your business before, during, and after its launch. Read more
	Operating Planning: An explanation of the systems, processes, and tools necessary to efficiently run your business behind the scenes. Read more
	Organization and Management: Organization and management in a business plan outline the structure and leadership of the company. Read more
	Financial Plan: A comprehensive plan mapping out your short-term and long-term financial goals and the associated costs of running your business. If you require funding, this section is where you can outline your request and financial needs. Read more
	Key External Drivers: External drivers encompass factors like outsourcing, economic changes, industry competition, and business legislation complexity. Read more
	Startup Summary: The startup summary offers a comprehensive financial overview of , detailing expenses, asset value, and total requirements, crucial for transparency with entrepreneurs and investors. Read more
	Projected Industry Growth : Projected industry growth forecasts the sector’s expansion, offering a 10-year perspective and average annual growth rate, providing clarity to investors. Read more
	Break-even analysis: The break-even analysis visually presents key metrics and a 12-month revenue forecast to help stakeholders grasp the point where the business covers costs and starts generating profit . Read more
	Management Summary: The management summary provides a concise overview of organizational structure, key personnel, their roles, and financial commitments, ensuring stakeholders understand the business’s operational strength and leadership capability. Read more
	Financial Indicators: The financial indicators section evaluates organizational fiscal health, focusing on year-over-year profitability metrics, leverage ratios, liquidity ratios, and additional metrics, providing a comprehensive understanding of the business’s financial performance and efficiency in revenue generation from equity investments. Read more

Practical Business Plan Examples Illustrating Strategies for Startup Success

Something Borrowed Something New is a burgeoning e-commerce enterprise specializing in wedding accessories and personalized gifts. Operating on a drop-shipping model, this business has the capability to make a significant impact in the market.
Moreover, leveraging social networking and blogging can be instrumental in generating awareness and capturing interest, thereby creating a robust online marketing strategy for Something Old and Something New.
To enhance their business operations, they are contemplating the integration of a WhatsApp CRM system. This initiative aims to optimize communication with potential customers, ensuring prompt responses to inquiries and fostering a seamless interaction process.

EPlace Solutions will be an innovative online marketplace business portal offering a variety of products to consumers throughout the globe. Founded by Mr. John Jones, a seasoned business visionary with an eye toward profit and achievement, the organization is set to enter the market in 2023.
Online shopping is at an all-time high with new consumer mindsets calling for them to shop for the types of deals and bargains that will be so much a part of the online marketplace business model.

There is an increasing demand for snack-type fast food to be consumed while window shopping and walking around inside a shopping mall.
Do you plan to start a snack bar business? Then here’s a complete snack bar startup business plan template and feasibility report you can use FREE of charge. It sounds easy to open a snack bar, but in reality, you need well-planned strategies to ensure that your business stands the test of time. 
Our snack bar business plan sample includes a detailed description of the products and services offered, as well as a market a nalysis  and competitive analysis.
It also includes a financial plan that outlines the startup costs, revenue projections, and break-even analysis. We like this sample plan because it demonstrates how to build a profitable snack bar business by creating a unique menu and offering healthy, high-quality snac ks that meet custome r demand.
Your snack shop business plan can look as polished and professional as the sample plan. It’s fun and easy, with Wise Business Plan. Let’s review the  snack shop business plan sample  and adjust them according to your audience for the best results.

A coffee shop business plan is a document that outlines what your business idea is and how it will be implemented. Its purpose is to answer questions such as what it costs to start a coffee shop, how these costs will be financed, and how much money you can expect to earn from your cafe.
Are you looking for the right business plan for your cafe? Let’s review the  Coffee shop business plan sample  to find out how cloud-based software can make your day-to-day work more efficient.
Our coffee shop business plan sample includes a detailed description of the products and services offered, as well as a market analysis and competitive analysis.
It also includes a financial plan that outlines the startup costs, revenue projections, and break-even analysis. We like this sample plan because it demonstrates how to build a profitable coffee shop business by creating a unique brand and offering high-quality products a nd customer service.

In the food industry, there is fierce competition. To ensure success, you need to hit the ground running with the right pitch. Our food house business plan is the ideal solution with an attractive design highlighting key information and conveying the right message.
This food business plan example features food images intended to tantalize the taste buds. It captures the theme perfectly and will convey the ultimate message to investors, clients and customers.
It is important to remember that the business plan template can be customized to meet your company’s specific needs and requirements. It will help showcase your business as a leader in the modern industry.
This food business plan template provides key slides to showcase everything from finances to marketing and key competitors. If you prefer, you can alter the content displayed to meet your specific needs, but this is a good starting point.
Ultimately, this  food house business plan  will be suitable for any business operating in the food industry and keen to get interested from key individuals. It will ensure that you can build up the rep of your company.
We provide a one-of-a-kind sales pitch deck designed to appeal to your prospective audience, as well as a custom presentation tailored to their information requirements.

When establishing a think tank, you will need to develop a business plan and document it properly. As a mass think tank, you need a special strategy to legalize the think tank as a non-profit organization and to raise funds for your project successfully.
Copy and print businesses offer a variety of services to both businesses and consumers. A copy and print shop can handle everything from single-page printing to large-volume jobs using several types of media.
Our printing shop business plan sample includes a detailed description of the products and services offered, as well as a market analysis and competitive analysis. It also includes a financial plan that outlines the startup costs, revenue projections, and break-even analysis. We like this sample plan because it demonstrates how to build a profitable printing shop business by offering high-quality, customized printing services with a focus on customer s ervice and efficient operations.
Let’s take a look at Printing and Photocopy Business Plan Sample that you can use to inspire your own and easily create one.

The acquisition business plan sample is intended for businesses seeking to acquire another company or merge with a competitor. This plan includes an analysis of the target company, a valuation, and a strategy for integrating the acquired business into the existing operations. We like this sample plan because it provides a clear roadmap for the acquisition process and demonstrates the potential benefits of the deal.

At Wisebusinessplans, we understand that obtaining an L1 visa for an executive or manager requires a thorough and compelling business plan.
Our L1 business plan sample includes all the necessary components to satisfy USCIS requirements and demonstrate your qualifications and your company’s viability in the US market.
The L1 business plan sample is a comprehensive plan for a new business seeking L1 visa approval for an executive or manager. This plan focuses on demonstrating the applicant’s qualifications and the company’s viability in the US market.
We like this sample plan because it is specific to the L1 visa process and includes all the necessary components to satisfy USCIS requirements.

If you’re an entrepreneur seeking E-2 visa approval, Wise Business Plans can help you create a persuasive business plan.
Our E-2 business plan sample outlines your investment, business operations, and financial projections, providing a clear and compelling case for your ability to successfully run a business and make a significant economic impact.
The E-2 business plan sample is designed for entrepreneurs seeking E-2 visa approval, which allows individuals to invest in and manage a business in the United States. This plan outlines the applicant’s investment, business operations, and financial projections. We like this sample plan because it provides a clear and compelling case for the applicant’s ability to successfully run a business and make a significant economic impact.

If you’re looking to obtain an EB-5 visa by investing in a new commercial enterprise in the United States, Wise Business Plans can help you create a compelling business plan.
Our EB-5 business plan sample includes a description of your business, a market analysis, and financial projections, providing a detailed and persuasive case for the potential success of your venture.
The EB-5 business plan sample is designed for individuals seeking to obtain an EB-5 visa by investing in a new commercial enterprise in the United States. This plan includes a description of the business, a market analysis, and financial projections. We like this sample plan because it provides a detailed and persuasive case for the potential success of the business, which is crucial for obtaining EB-5 visa approval.

If you’re seeking investment from angel investors, venture capitalists, or other private equity firms, Wise Business Plans can help you create a compelling pitch.
Our investor business plan sample includes a pitch deck, financial projections, and a detailed analysis of the market the potential return on investment and the scalability of your business.
The investor business plan sample is intended for businesses seeking to attract investment from angel investors, venture capitalists, or other private equity firms. This plan includes a pitch deck, financial projections, and a detailed analysis of the market opportunity. We like this sample plan because it emphasizes the potential return on investment and the scalability of the business.

At Wisebusinessplans, we’re committed to helping non-profit organizations achieve their social impact goals.
Our non-profit business plan sample includes a mission statement, programs and services, marketing and outreach strategies, and a financial analysis, providing a clear roadmap for establishing or expanding your organization.
The non-profit business plan sample is designed for organizations seeking to establish or expand a non-profit entity. This plan includes a mission statement, programs and services, marketing and outreach strategies, and a financial analysis. We like this sample plan because it demonstrates a strong commitment to social impact and outlines a clear strategy for achieving the organization’s goals.

Whether you’re seeking financing from a bank or other financial institution, Wise Business Plans can help you create a detailed and persuasive business plan.
Our bank business plan sample includes a thorough financial analysis, market research, and a strategy for achieving profitability, highlighting the key factors that banks consider when evaluating loan applications.
The bank business plan sample is tailored for businesses seeking financing from a bank or other financial institution. This plan includes a detailed financial analysis, market research, and a strategy for achieving profitability. We like this sample plan because it highlights the key factors that banks consider when evaluating loan applications, and provides a strong case for the borrower’s ability to repay the loan.

The cannabis industry is rapidly growing, and Wise Business Plans can help you enter it with confidence.
Our cannabis business plan sample includes a market analysis, operational strategy, and regulatory compliance a comprehensive overview of the unique challenges and opportunities in the industry and offering a clear roadmap for success.
The cannabis business plan sample is tailored for entrepreneurs seeking to enter the rapidly growing cannabis industry. This plan includes a market analysis, operational strategy, and regulatory compliance plan. We like this sample plan because it provides a comprehensive overview of the unique challenges and opportunities in the cannabis industry, and offers a clear roadmap for success.
1. Executive Summary
The executive summary is a concise overview of your business plan, highlighting the key points of each section. It should capture the essence of your business, its mission, and the purpose of the business plan. This section should be written last, but it’s placed at the beginning of the business plan. Here is an example executive summary from our professional business plan written for Eplace Solution , an innovative e-commerce portal.

	Keep it brief and focused on key points.
	Clearly define the problem and your solution.
	Highlight market opportunities and growth potential.
	Showcase your team’s qualifications.
	Include financial projections.
	End with a clear call to action.
	Tailor it to your audience.
	Review and update regularly.


2. Company Overview or Description
In this section, provide a detailed description of your company, including its history, legal structure, location, and vision. Explain your mission statement and core values that guide your business decisions. Use real-life examples of successful companies and how their strong company descriptions have contributed to their growth. In addition, you can reuse your company description on your About page, Instagram page, or other properties that ask for a boilerplate description of your business.
This section also allows you to describe how you register your business . Here you must choose whether your business is a corporation, sole proprietorship, LLC , or another type of business .

	Describe your company’s mission and vision.
	Explain what your business does and the problems it solves.
	Mention your target market and customer base.
	Highlight your unique selling points.
	Provide a brief history and background.

3. Market Analysis
A market analysis analyzes how you are positioned in the market, who your target customers are, what your product or service will offer them, and industry trends. It might be useful to do a SWOT analysis to discover your strengths and weaknesses to identify market gaps that you may be able to exploit to build your business.
As part of your market research, you’ll also need to perform a competitive analysis. It will give you an idea of who your competition is and how to differentiate your brand. Here’s an example of a competitive analysis we did for a food business.

	Research and understand your industry thoroughly.
	Identify market trends and growth opportunities.
	Analyze your competitors and their strengths and weaknesses.
	Define your target audience and their needs.
	Include data and statistics to support your analysis.


4. Product and Services
Adding products and services to a business plan involves more than listing your company’s offerings. If you intend to gain funding or partner with another business, your products, and services section needs to demonstrate your company’s quality, value, and benefits.
Here’s an example of a product and service section in the business plan we wrote for an e-commerce business that offers wedding accessories.

	Clearly describe your offerings and their features.
	Explain how your products/services address customer needs.
	Highlight any unique qualities or advantages.
	Discuss your pricing strategy.
	Mention any future product/service development plans.

Here is example of services section of a bank.

5. Marketing and Sales Plan
It is always a good idea to have a marketing plan before launching your business. A potential investor will want to know how you will advertise your business. Therefore, you should create a marketing plan that explains your planned promotion and customer acquisition strategies.
Discuss how you will make a sale. How will you attract customers and maximize their lifetime value? Ensure your marketing and sales forecasts align with your financial forecasts Marketing plans are usually based on the four Ps : product, price, place, and promotion. Breaking it down by marketing channels makes it easier. Discuss how you intend to market your business via blogs, email, social media, and word-of-mouth. Here is an example of marketing strategies we develop for a restaurant business.

	Define your marketing goals and objectives.
	Outline your marketing strategies, including channels and tactics.
	Explain your sales strategy and target sales goals.
	Include a budget for marketing and sales activities.
	Discuss your sales team and their roles.
	Detail your customer acquisition and retention strategies.
	Mention any partnerships or collaborations for marketing and sales.

Example of marketing and sales plan section of a bank

6. Operation Planning
The operation plan should include all the steps needed to run the business in the long run. The plan should include details about logistics, duties for each department of the company, and responsibilities for the team.
The main aspect of running a business is its costs. Whether it’s machinery or services, each requires capital.
how to write an operation plan in a business plan
	Describe your day-to-day business operations.
	Explain your supply chain and production processes.
	Outline your facility and equipment requirements.
	Discuss your quality control and efficiency measures.
	Mention any legal and regulatory compliance considerations.
	Detail your staffing and management structure.
	Include contingency plans for potential disruptions.

7. Organization and Management
In this section, you can describe your current team and the people you need to hire. You will need to highlight your team’s relevant experience if you intend to seek funding. Basically, this is where you demonstrate that this team can be successful in starting and growing the business.

	Introduce your leadership team and their roles.
	Highlight their relevant experience and qualifications.
	Explain your organizational structure and hierarchy.
	Discuss key personnel responsibilities and functions.
	Mention any plans for team growth or development.
	Address any advisory boards or external support.

Management summary of coffee shoppe business.

8. Financial Plan
A financial plan should include sales and revenue forecasts, profit and loss statements , cash flow statements , and balance sheets .
Now, if you plan to pitch investors or submit a loan application, you’ll also need a “use of funds” report. Here you outline how you plan to leverage any funding you might acquire for your business.
With our business templates , you can create your own income statement, cash flow statement, and balance sheet.

	Include detailed financial projections (income statement, cash flow, balance sheet).
	Explain your funding requirements and sources.
	Discuss your pricing and revenue model.
	Describe your expense management and cost controls.
	Mention any financial risks and mitigation strategies.
	Highlight key financial milestones and goals.

Financial highlights of foodShack business.

9. Key External Drivers
External drivers refer to the external factors or influences that significantly impact the activity and growth of an industry. These drivers include outsourcing of non-core activities, changes in economic activity, competition from other industries, and the complexity of business legislation.
Additionally, external drivers encompass the effects of changes in new business formation, especially among small businesses, which directly affect the demand for services within the industry.

	Identify and analyze current and emerging market trends in your industry.
	Assess potential positive or negative impacts these trends may have on your business.
	Evaluate broader economic conditions, including inflation rates, interest rates, and GDP growth.
	Elucidate how changes in economic conditions could influence consumer behavior, product demand, and overall cost structure.
	Outline key industry regulations and compliance requirements, discussing potential impacts on operations, costs, and market access.
	Highlight relevant technological advancements and explain their potential effects on your product or service offerings, operations, and competitiveness.
	Analyze current and potential future competitors, emphasizing the evolving competitive landscape’s impact on market share, pricing strategy, and overall business strategy.
	Consider social and cultural factors influencing consumer preferences and behaviors, exploring how societal changes can affect product demand.
	Evaluate environmental trends and regulations, discussing potential impacts on operations, supply chain, and customer perceptions.
	Assess political stability, government policies, and geopolitical factors, exploring potential risks and opportunities from political changes.
	Discuss global market conditions, analyzing how global economic trends, trade policies, and currency fluctuations may affect operations and expansion plans.
	Identify and discuss potential risks in the supply chain, such as disruptions, shortages, or geopolitical issues.
	Consider demographic shifts affecting your target market and discuss how changes may impact your customer base and marketing strategies.
	Highlight key legal and regulatory factors affecting the business, discussing potential legal challenges, compliance costs, and regulatory changes.
	Outline comprehensive risk management strategies, including contingency plans and risk mitigation strategies.
	Explain how you will monitor external drivers and emphasize the importance of staying agile and responsive to changes in the external environment.


10. Startup Summary
The startup summary serves as a comprehensive overview of essential financial aspects, encompassing total startup expenses, the overall value of startup assets, and the total requirements, which is the cumulative sum of all expenses and startup investments.
It provides a clear financial snapshot, outlining the costs involved in launching the business, the value of assets acquired, and the overall financial needs for the startup.
This section is crucial for entrepreneurs and potential investors, offering a transparent understanding of the financial foundation required to initiate and sustain the business successfully.
This roadmap ensures a realistic evaluation of the business idea, identifying potential challenges and offering solutions.To write an effective plan, focus on what sets your venture apart from competitors, maintain conciseness, and embrace flexibility as a living document.
Answer fundamental questions about your business, create actionable checklists, execute the plan, and continually revise and update based on experiences and feedback.This iterative process fosters continuous improvement, helping entrepreneurs stay adaptable and enhance their business strategies over time.

	Clearly state the startup’s name and provide a concise description of its activities.
	Include a succinct mission statement capturing the startup’s purpose and goals, reflecting its core values.
	Specify the founding date and offer brief bios of key founders, highlighting relevant experience.
	Summarize the startup’s concept, explaining offered products or services and key distinguishing features.
	Clearly articulate the problem or need in the market that the startup addresses, defining the target audience.
	State what makes the startup unique, whether it’s a special feature, market gap, or competitive advantage.
	Provide a brief description of the market opportunity, covering target market size, trends, and growth prospects.
	Outline how the startup plans to generate revenue, detailing streams, pricing strategy, and potential partnerships.
	Offer a snapshot of the startup’s current status, highlighting key achievements such as product development or partnerships.
	If seeking funding, clearly state the amount sought and its allocation, covering areas like product development and marketing.
	Include a high-level financial summary with key projections for revenue, expenses, and profitability.
	Briefly outline future aspirations and plans, encompassing areas like expansion, product development, or strategic partnerships.

11. Projected Industry Growth
The projected industry growth is a pivotal aspect that forecasts the expansion of a specific sector over a defined timeframe.
For instance, it could provide an estimate of where that particular business will be standing in the next 10 years, and what will be the average annual growth rate of that industry.
This information provides prospective investors and stakeholders with a clear understanding of the industry’s potential and positions the startup within a dynamic and flourishing market.

	Emphasize the importance of industry trends and growth to your business.
	Provide a concise overview, including market size, major players, and recent trends.
	Briefly explain how you gathered data on industry growth projections (e.g., market research reports, expert interviews).
	Identify and discuss prevailing trends, such as technological advancements, changes in consumer behavior, and regulatory shifts.
	Summarize the industry’s historical growth, highlighting growth rates, market expansion, and notable milestones.
	Highlight key factors expected to drive industry growth, such as emerging markets, technological innovations, and demographic shifts.
	Discuss specific opportunities within the industry, including gaps in the market, underserved segments, or areas of competitive advantage.
	Acknowledge potential challenges or risks that could impact industry growth, demonstrating a realistic understanding.
	Present projections for future growth rates based on historical data, expert opinions, and your analysis. Include short-term and long-term projections.
	Discuss how key competitors are positioned to leverage industry growth, emphasizing your business’s differentiation strategies.
	Consider the regulatory landscape impacting growth, discussing anticipated changes and their potential effects on the industry.
	Explore international trends and their implications for industry growth, including factors like global economic conditions and geopolitical influences.

Here is example of market analysis section of a bank.

12. Break-even Analysis
The break-even analysis serves as a vital financial tool, offering a detailed estimation of key metrics such as Sales Revenue, Cost of Sales, Gross Profit, Fixed Expenses, and Income Before Tax.
These critical components are visually presented through a bar graph, providing a clear and concise overview of the financial dynamics.
Additionally, the break-even analysis delves into a 12-month forecast, outlining the projected amount of revenue generated and the corresponding fixed costs.
This section is instrumental in helping stakeholders understand the financial threshold at which the business covers its costs and begins to generate profit.

	Define break-even analysis as a financial calculation where total revenue equals total costs.
	Identify constant costs regardless of production or sales levels.
	Enumerate and explain costs changing with production or sales.
	Present the break-even analysis formula, indicating the units needed to cover costs.
	Perform a practical break-even calculation using business-specific fixed costs, selling price, and variable cost per unit.
	Include a break-even chart or graph for a visual understanding of cost-revenue dynamics.
	Conduct a proactive sensitivity analysis to explore how changes in variables impact the break-even point.
	Specify the anticipated timeframe to reach the break-even point in terms of months or units sold.
	Clearly outline assumptions made in the analysis and provide justifications for transparency and credibility.
	Acknowledge potential risks or challenges that may affect the accuracy of the break-even analysis.
	Briefly mention contingency plans for difficulties in reaching the break-even point within the projected timeframe.

13. Management Summary
The management summary within the business plan provides a concise overview of the organizational structure and key personnel.
This includes a count of individuals, specifying the number of founders and operational team members integral to the organization.
The summary delves into the roles and responsibilities of each key figure, offering insights into the leadership dynamics driving the business.
Furthermore, the management summary sheds light on the financial aspect by presenting details about personal wages and payroll allocations for both founders and operational staff.
This comprehensive section ensures a clear understanding of the human resource framework and the financial commitments associated with the management team, crucial for stakeholders evaluating the business’s operational strength and leadership capability.

	Highlighting the critical role the management team plays in the business’s success, the introduction emphasizes their significance.
	Listing each key member with names, positions, and brief role summaries introduces the core of the management team.
	Providing brief biographies for each team member underscores their relevant experience, skills, achievements, and industry-specific expertise.
	Clearly outlining roles and responsibilities emphasizes how each team member’s skills contribute to the overall success of the business.
	Sharing the team’s vision and strategy involves discussing key strategic goals and outlining the plans to achieve them.
	Highlighting notable achievements or milestones showcases the team members’ successful ventures, industry recognition, or career accomplishments.
	Discussing team dynamics emphasizes collaboration and the complementary nature of their skills in driving the business forward.
	Introducing advisory board members, if applicable, underscores the additional guidance and expertise they bring to the business.
	Discussing how the team plans to contribute to future growth and development includes strategies for talent acquisition, leadership development, and succession planning.
	Touching on the team’s culture and values emphasizes their role in shaping the overall ethos of the business.
	If seeking investment, briefly mentioning how the management team plans to use funding for business growth and development provides insight into their financial strategy.

Here is example of marketing and sales plan section of a bank.

14. Financial Indicators
The financial indicators section within the business plan helps in evaluating the fiscal health and performance of the organization.
Year-after-year profitability estimates take center stage, encompassing key metrics such as gross margin, net profit margin, and EBITDA to revenue.
These indicators provide a comprehensive understanding of the business’s ability to generate profit relative to its revenue.
Furthermore, the financial indicators extend to leverage ratios, including the critical Debt to Equity ratio, Debt to Assets ratio, and Interest Coverage ratio.
These metrics illuminate the organization’s capital structure, debt management, and its capacity to meet interest obligations.
Liquidity ratios includes the Current Ratio and Current Debt to Total Asset Ratio.
These ratios provide insights into the company’s short-term financial health and its ability to meet immediate obligations.
The financial indicator toolbox is enriched with additional metrics, notably the Revenue to Equity ratio, which sheds light on the efficiency of generating revenue from equity investments.

	Detailed revenue forecasts for the next 3-5 years. Breakdown by product/service and geographical regions.
	Detailed breakdown of anticipated expenses. Include fixed and variable costs, operational expenses, and other relevant expenditures.
	Historical P&L statements if available. Projected future profits and losses based on revenue and expense projections.
	Outline of expected cash inflows and outflows. Emphasis on the ability to meet short-term obligations.
	Snapshot of the company’s financial position. Includes assets, liabilities, and equity.
	Calculation and presentation of key financial ratios (liquidity, solvency, profitability). Discussion on the significance of these ratios.
	Identification and explanation of relevant KPIs. Highlighting alignment with the overall business strategy.
	Discussion of potential financial risks. Mitigation strategies and addressing uncertainties.
	Clear statement of the amount and purpose of funds required.
	Outline of key assumptions underlying financial projections. Rationale for these assumptions.
	Summary of industry financial trends and business positioning. Outlook on future financial prospects considering market dynamics.


Looking For The Right Business Plan Format?
These sample business plans will provide you with a complete structure and format for your business plan, which will give you a head start on developing your document, so you won’t be stuck seeing an empty page and wondering what to write.
Simply going through the process of writing a business plan is one of its key benefits. If you sit down to write, you’ll naturally think about your startup costs, your target market , and any market analysis or research you’ll need to conduct. In addition to defining your position among your competitors, you will establish your goals and milestones.
You can see what should be included in a sample financial plan, but It is wrong to assume that a sample company’s financial projections will fit your own. If you need more resources to get you started, we recommend this guide on how to write a business plan .
In addition, you can download our 40+ free business plan templates covering a range of industries.
Common Types of Business Plan
One-page business plans are short, compact, and to the point and are designed to make the plan easy to read at a glance. Make sure to include all of the sections, but truncate and summarize them
Start-up business plans are for businesses that are just getting started. They are usually developed to secure outside funding. In this regard, financials are of increased importance, as well as other sections that determine whether your business idea is viable, such as market research.
A strategic business plan lays out a company’s goals and how it will achieve them at a high level. It is a foundational document for the company as a whole. A strategic business plan allows all levels of the business to see the big picture, inspiring employees to work together to reach the company’s goals.
Developing a feasibility plan answers two primary questions about a business venture: who would purchase the service or product the company wants to sell, and if the venture is profitable.
Internal Business plans are geared to a specific audience within a company to keep your team on the same page and focused on the same goals.
In conclusion, whether you’re venturing into a traditional business or creating an innovative startup, the significance of a well-crafted business plan cannot be overstated. Different types of business plans cater to specific needs, from internal alignment to strategic expansion. Employing a template in MS Word ensures a polished presentation. The process of writing an executive summary, creating a plan, and defining the components of your business plan is essential.
Recognizing the need for a comprehensive and standard business plan can help guide your endeavors. Whether you choose to write a full business plan or opt for a one-page business overview, leveraging templates in MS Word can simplify the process. In essence, understanding the types of business plans and utilizing an executive summary template provides a structured approach to showcase your business overview.
Take inspiration from example business plans to tailor your strategy, ensuring a roadmap for success in the dynamic world of entrepreneurship. Always remember, a meticulously crafted business plan not only communicates your vision effectively but also serves as a valuable resource that can help secure investments and guide your business’s growth trajectory.
Begin with an executive summary, delve into market analysis, outline your strategies, create financial projections, and use available business plan examples as templates to guide your writing.
A comprehensive business plan template should encompass key sections such as an executive summary, business description, market analysis, marketing strategy, organizational structure, and financial projections. Seek templates online that cover these elements.
Tailor your business plan to the scale of your small business. Define your objectives clearly, outline cost-effective strategies, and emphasize agility in adapting to market changes.
Explore well-crafted business plan examples you can visit our website  wisebusinessplan.
The fundamental components include an executive summary, business description, market analysis, marketing and sales strategy, organizational structure, product/service description, and financial projections.
Investors focus on growth potential, detailed financial projections, market analysis, competition analysis, and the qualifications and experience of your management team when reviewing a business plan.
To find a business plan example for a tech startup,you can visit our visit wisebusinessplan .
A business plan provides a comprehensive overview of your entire business, including strategies, operations, and financials. In contrast, a business proposal typically focuses on a specific project or offer, outlining the details and benefits to a potential client.
Craft an engaging executive summary by summarizing your business’s mission, highlighting the market opportunity, showcasing your product or service, and providing a concise overview of your financial projections.
Seek tailored business plan examples for nonprofit organizations you can visit wisebusinessplan .
These business plans are written by MBA writers. Real-world use cases were used in these plans.
Get our business plan writing and consultation service.
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Free Business Plan Template

The essential document for starting a business -- custom built for your needs.
Thank you for downloading the offer.
I believe that reading sample business plans is essential when writing your own.
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As you explore business plan examples from real companies and brands, it’s easier for you to learn how to write a good one.
But what does a good business plan look like? And how do you write one that’s both viable and convincing. I’ll walk you through the ideal business plan format along with some examples to help you get started.
Table of Contents
Business Plan Format
Business plan types, sample business plan templates, top business plan examples.
Ask any successful sports coach how they win so many games, and they’ll tell you they have a unique plan for every single game. To me, the same logic applies to business.
If you want to build a thriving company that can pull ahead of the competition, you need to prepare for battle before breaking into a market.
Business plans guide you along the rocky journey of growing a company. And if your business plan is compelling enough, it can also convince investors to give you funding.
With so much at stake, I’m sure you’re wondering where to begin.

	Outline your idea.
	Pitch to investors.
	Secure funding.
	Get to work!

You're all set!
Click this link to access this resource at any time.
Fill out the form to get your free template.
First, you’ll want to nail down your formatting. Most business plans include the following sections.
1. Executive Summary
I’d say the executive summary is the most important section of the entire business plan. 
Why? Essentially, it's the overview or introduction, written in a way to grab readers' attention and guide them through the rest of the business plan. This is important, because a business plan can be dozens or hundreds of pages long.
There are two main elements I’d recommend including in your executive summary:
Company Description
This is the perfect space to highlight your company’s mission statement and goals, a brief overview of your history and leadership, and your top accomplishments as a business.
Tell potential investors who you are and why what you do matters. Naturally, they’re going to want to know who they’re getting into business with up front, and this is a great opportunity to showcase your impact.
Need some extra help firming up those business goals? Check out HubSpot Academy’s free course to help you set goals that matter — I’d highly recommend it
Products and Services
To piggyback off of the company description, be sure to incorporate an overview of your offerings. This doesn’t have to be extensive — just another chance to introduce your industry and overall purpose as a business.
In addition to the items above, I recommend including some information about your financial projections and competitive advantage here too.:
Keep in mind you'll cover many of these topics in more detail later on in the business plan. So, keep the executive summary clear and brief, and only include the most important takeaways.
Executive Summary Business Plan Examples
This example was created with HubSpot’s business plan template:

This executive summary is so good to me because it tells potential investors a short story while still covering all of the most important details.

Image Source
Tips for Writing Your Executive Summary
	Start with a strong introduction of your company, showcase your mission and impact, and outline the products and services you provide.
	Clearly define a problem, and explain how your product solves that problem, and show why the market needs your business.
	Be sure to highlight your value proposition, market opportunity, and growth potential.
	Keep it concise and support ideas with data.
	Customize your summary to your audience. For example, emphasize finances and return on investment for venture capitalists.

Check out our tips for writing an effective executive summary for more guidance.
2. Market Opportunity
This is where you'll detail the opportunity in the market.
The main question I’d ask myself here is this: Where is the gap in the current industry, and how will my product fill that gap?
More specifically, here’s what I’d include in this section:
	The size of the market
	Current or potential market share
	Trends in the industry and consumer behavior
	Where the gap is
	What caused the gap
	How you intend to fill it

To get a thorough understanding of the market opportunity, you'll want to conduct a TAM, SAM, and SOM analysis and perform market research on your industry.
You may also benefit from creating a SWOT analysis to get some of the insights for this section.
Market Opportunity Business Plan Example
I like this example because it uses critical data to underline the size of the potential market and what part of that market this service hopes to capture.

Tips for Writing Your Market Opportunity Section
	Focus on demand and potential for growth.
	Use market research, surveys, and industry trend data to support your market forecast and projections.
	Add a review of regulation shifts, tech advances, and consumer behavior changes.
	Refer to reliable sources.
	Showcase how your business can make the most of this opportunity.


3. Competitive Landscape
Since we’re already speaking of market share, you'll also need to create a section that shares details on who the top competitors are.
After all, your customers likely have more than one brand to choose from, and you'll want to understand exactly why they might choose one over another.
My favorite part of performing a competitive analysis is that it can help you uncover:
	Industry trends that other brands may not be utilizing
	Strengths in your competition that may be obstacles to handle
	Weaknesses in your competition that may help you develop selling points
	The unique proposition you bring to the market that may resonate with customers

Competitive Landscape Business Plan Example
I like how the competitive landscape section of this business plan below shows a clear outline of who the top competitors are.

It also highlights specific industry knowledge and the importance of location, which shows useful experience in this specific industry. 
This can help build trust in your ability to execute your business plan.
Tips for Writing Your Competitive Landscape
	Complete in-depth research, then emphasize your most important findings.
	Compare your unique selling proposition (USP) to your direct and indirect competitors.
	Show a clear and realistic plan for product and brand differentiation.
	Look for specific advantages and barriers in the competitive landscape. Then, highlight how that information could impact your business.
	Outline growth opportunities from a competitive perspective.
	Add customer feedback and insights to support your competitive analysis.

4. Target Audience
Use this section to describe who your customer segments are in detail. What is the demographic and psychographic information of your audience?
If your immediate answer is "everyone," you'll need to dig deeper. Here are some questions I’d ask myself here:
	What demographics will most likely need/buy your product or service?
	What are the psychographics of this audience? (Desires, triggering events, etc.)
	Why are your offerings valuable to them?

I’d also recommend building a buyer persona to get in the mindset of your ideal customers and be clear on why you're targeting them.
Target Audience Business Plan Example
I like the example below because it uses in-depth research to draw conclusions about audience priorities. It also analyzes how to create the right content for this audience.

Tips for Writing Your Target Audience Section
	Include details on the size and growth potential of your target audience.
	Figure out and refine the pain points for your target audience , then show why your product is a useful solution.
	Describe your targeted customer acquisition strategy in detail.
	Share anticipated challenges your business may face in acquiring customers and how you plan to address them.
	Add case studies, testimonials, and other data to support your target audience ideas.
	Remember to consider niche audiences and segments of your target audience in your business plan.

5. Marketing Strategy
Here, you'll discuss how you'll acquire new customers with your marketing strategy. I’d suggest including information:
	Your brand positioning vision and how you'll cultivate it
	The goal targets you aim to achieve
	The metrics you'll use to measure success
	The channels and distribution tactics you'll use

I think it’s helpful to have a marketing plan built out in advance to make this part of your business plan easier.
Marketing Strategy Business Plan Example
This business plan example includes the marketing strategy for the town of Gawler.
In my opinion, it really works because it offers a comprehensive picture of how they plan to use digital marketing to promote the community.

Tips for Writing Your Marketing Strategy
	Include a section about how you believe your brand vision will appeal to customers.
	Add the budget and resources you'll need to put your plan in place.
	Outline strategies for specific marketing segments.
	Connect strategies to earlier sections like target audience and competitive analysis.
	Review how your marketing strategy will scale with the growth of your business.
	Cover a range of channels and tactics to highlight your ability to adapt your plan in the face of change.

6. Key Features and Benefits
At some point in your business plan, you'll need to review the key features and benefits of your products and/or services.
Laying these out can give readers an idea of how you're positioning yourself in the market and the messaging you're likely to use. It can even help them gain better insight into your business model.
Key Features and Benefits Business Plan Example
In my opinion, the example below does a great job outlining products and services for this business, along with why these qualities will attract the audience.

Tips for Writing Your Key Features and Benefits
	Emphasize why and how your product or service offers value to customers.
	Use metrics and testimonials to support the ideas in this section.
	Talk about how your products and services have the potential to scale.
	Think about including a product roadmap.
	Focus on customer needs, and how the features and benefits you are sharing meet those needs.
	Offer proof of concept for your ideas, like case studies or pilot program feedback.
	Proofread this section carefully, and remove any jargon or complex language.

7. Pricing and Revenue
This is where you'll discuss your cost structure and various revenue streams. Your pricing strategy must be solid enough to turn a profit while staying competitive in the industry. 
For this reason, here’s what I’d might outline in this section:
	The specific pricing breakdowns per product or service
	Why your pricing is higher or lower than your competition's
	(If higher) Why customers would be willing to pay more
	(If lower) How you're able to offer your products or services at a lower cost
	When you expect to break even, what margins do you expect, etc?

Pricing and Revenue Business Plan Example
I like how this business plan example begins with an overview of the business revenue model, then shows proposed pricing for key products.

Tips for Writing Your Pricing and Revenue Section
	Get specific about your pricing strategy. Specifically, how you connect that strategy to customer needs and product value.
	If you are asking a premium price, share unique features or innovations that justify that price point.
	Show how you plan to communicate pricing to customers.
	Create an overview of every revenue stream for your business and how each stream adds to your business model as a whole.
	Share plans to develop new revenue streams in the future.
	Show how and whether pricing will vary by customer segment and how pricing aligns with marketing strategies.
	Restate your value proposition and explain how it aligns with your revenue model.

8. Financials
To me, this section is particularly informative for investors and leadership teams to figure out funding strategies, investment opportunities, and more.
 According to Forbes , you'll want to include three main things:
	Profit/Loss Statement - This answers the question of whether your business is currently profitable.
	Cash Flow Statement - This details exactly how much cash is incoming and outgoing to give insight into how much cash a business has on hand.
	Balance Sheet - This outlines assets, liabilities, and equity, which gives insight into how much a business is worth.

While some business plans might include more or less information, these are the key details I’d include in this section.
Financials Business Plan Example
This balance sheet is a great example of level of detail you’ll need to include in the financials section of your business plan.

Tips for Writing Your Financials Section
	Growth potential is important in this section too. Using your data, create a forecast of financial performance in the next three to five years.
	Include any data that supports your projections to assure investors of the credibility of your proposal.
	Add a break-even analysis to show that your business plan is financially practical. This information can also help you pivot quickly as your business grows.
	Consider adding a section that reviews potential risks and how sensitive your plan is to changes in the market.
	Triple-check all financial information in your plan for accuracy.
	Show how any proposed funding needs align with your plans for growth.

As you create your business plan, keep in mind that each of these sections will be formatted differently. Some may be in paragraph format, while others could be charts or graphs.
The formats above apply to most types of business plans. That said, the format and structure of your plan will vary by your goals for that plan. 
So, I’ve added a quick review of different business plan types. For a more detailed overview, check out this post .
1. Startups
Startup business plans are for proposing new business ideas.
If you’re planning to start a small business, preparing a business plan is crucial. The plan should include all the major factors of your business.
You can check out this guide for more detailed business plan inspiration .
2. Feasibility Studies
Feasibility business plans focus on that business's product or service. Feasibility plans are sometimes added to startup business plans. They can also be a new business plan for an already thriving organization.
3. Internal Use
You can use internal business plans to share goals, strategies, or performance updates with stakeholders. In my opinion, internal business plans are useful for alignment and building support for ambitious goals.
4. Strategic Initiatives
Another business plan that's often for sharing internally is a strategic business plan. This plan covers long-term business objectives that might not have been included in the startup business plan.
5. Business Acquisition or Repositioning
When a business is moving forward with an acquisition or repositioning, it may need extra structure and support. These types of business plans expand on a company's acquisition or repositioning strategy.
Growth sometimes just happens as a business continues operations. But more often, a business needs to create a structure with specific targets to meet set goals for expansion. This business plan type can help a business focus on short-term growth goals and align resources with those goals.
Now that you know what's included and how to format a business plan, let's review some of my favorite templates.
1. HubSpot's One-Page Business Plan
Download a free, editable one-page business plan template..
The business plan linked above was created here at HubSpot and is perfect for businesses of any size — no matter how many strategies we still have to develop.
Fields such as Company Description, Required Funding, and Implementation Timeline give this one-page business plan a framework for how to build your brand and what tasks to keep track of as you grow.
Then, as the business matures, you can expand on your original business plan with a new iteration of the above document.
Why I Like It
This one-page business plan is a fantastic choice for the new business owner who doesn’t have the time or resources to draft a full-blown business plan. It includes all the essential sections in an accessible, bullet-point-friendly format. That way, you can get the broad strokes down before honing in on the details.
2. HubSpot's Downloadable Business Plan Template

We also created a business plan template for entrepreneurs.
The template is designed as a guide and checklist for starting your own business. You’ll learn what to include in each section of your business plan and how to do it.
There’s also a list for you to check off when you finish each section of your business plan.
Strong game plans help coaches win games and help businesses rocket to the top of their industries. So if you dedicate the time and effort required to write a workable and convincing business plan, you’ll boost your chances of success and even dominance in your market.
This business plan kit is essential for the budding entrepreneur who needs a more extensive document to share with investors and other stakeholders.
It not only includes sections for your executive summary, product line, market analysis, marketing plan, and sales plan, but it also offers hands-on guidance for filling out those sections.
3. LiveFlow’s Financial Planning Template with built-in automation

This free template from LiveFlow aims to make it easy for businesses to create a financial plan and track their progress on a monthly basis.
The P&L Budget versus Actual format allows users to track their revenue, cost of sales, operating expenses, operating profit margin, net profit, and more.
The summary dashboard aggregates all of the data put into the financial plan sheet and will automatically update when changes are made.
Instead of wasting hours manually importing your data to your spreadsheet, LiveFlow can also help you to automatically connect your accounting and banking data directly to your spreadsheet, so your numbers are always up-to-date.
With the dashboard, you can view your runway, cash balance, burn rate, gross margins, and other metrics. Having a simple way to track everything in one place will make it easier to complete the financials section of your business plan.
This is a fantastic template to track performance and alignment internally and to create a dependable process for documenting financial information across the business. It’s highly versatile and beginner-friendly.
It’s especially useful if you don’t have an accountant on the team. (I always recommend you do, but for new businesses, having one might not be possible.)
4. ThoughtCo’s Sample Business Plan

One of the more financially oriented sample business plans in this list, BPlan’s free business plan template dedicates many of its pages to your business’s financial plan and financial statements.
After filling this business plan out, your company will truly understand its financial health and the steps you need to take to maintain or improve it.
I absolutely love this business plan template because of its ease-of-use and hands-on instructions (in addition to its finance-centric components). If you feel overwhelmed by the thought of writing an entire business plan, consider using this template to help you with the process.
6. Harvard Business Review’s "How to Write a Winning Business Plan"
Most sample business plans teach you what to include in your business plan, but this Harvard Business Review article will take your business plan to the next level — it teaches you the why and how behind writing a business plan.
With the guidance of Stanley Rich and Richard Gumpert, co-authors of " Business Plans That Win: Lessons From the MIT Enterprise Forum ", you'll learn how to write a convincing business plan that emphasizes the market demand for your product or service.
You’ll also learn the financial benefits investors can reap from putting money into your venture rather than trying to sell them on how great your product or service is.
This business plan guide focuses less on the individual parts of a business plan, and more on the overarching goal of writing one. For that reason, it’s one of my favorites to supplement any template you choose to use. Harvard Business Review’s guide is instrumental for both new and seasoned business owners.
7. HubSpot’s Complete Guide to Starting a Business
If you’re an entrepreneur, you know writing a business plan is one of the most challenging first steps to starting a business.
Fortunately, with HubSpot's comprehensive guide to starting a business, you'll learn how to map out all the details by understanding what to include in your business plan and why it’s important to include them. The guide also fleshes out an entire sample business plan for you.
If you need further guidance on starting a business, HubSpot's guide can teach you how to make your business legal, choose and register your business name, and fund your business. It will also give small business tax information and includes marketing, sales, and service tips.
This comprehensive guide will walk you through the process of starting a business, in addition to writing your business plan, with a high level of exactitude and detail. So if you’re in the midst of starting your business, this is an excellent guide for you.
It also offers other resources you might need, such as market analysis templates.
8. Panda Doc’s Free Business Plan Template

PandaDoc’s free business plan template is one of the more detailed and fleshed-out sample business plans on this list. It describes what you should include in each section, so you don't have to come up with everything from scratch.
Once you fill it out, you’ll fully understand your business’ nitty-gritty details and how all of its moving parts should work together to contribute to its success.
This template has two things I love: comprehensiveness and in-depth instructions. Plus, it’s synced with PandaDoc’s e-signature software so that you and other stakeholders can sign it with ease. For that reason, I especially love it for those starting a business with a partner or with a board of directors.
9. Small Business Administration Free Business Plan Template

The Small Business Administration (SBA) offers several free business plan templates that can be used to inspire your own plan.
Before you get started, you can decide what type of business plan you need — a traditional or lean start-up plan.
Then, you can review the format for both of those plans and view examples of what they might look like.
We love both of the SBA’s templates because of their versatility. You can choose between two options and use the existing content in the templates to flesh out your own plan. Plus, if needed, you can get a free business counselor to help you along the way.
I’ve compiled some completed business plan samples to help you get an idea of how to customize a plan for your business.
I chose different types of business plan ideas to expand your imagination. Some are extensive, while others are fairly simple.
Let’s take a look.
1. LiveFlow

One of the major business expenses is marketing. How you handle your marketing reflects your company’s revenue.
I included this business plan to show you how you can ensure your marketing team is aligned with your overall business plan to get results. The plan also shows you how to track even the smallest metrics of your campaigns, like ROI and payback periods instead of just focusing on big metrics like gross and revenue.
Fintech startup, LiveFlow, allows users to sync real-time data from its accounting services, payment platforms, and banks into custom reports. This eliminates the task of pulling reports together manually, saving teams time and helping automate workflows.
"Using this framework over a traditional marketing plan will help you set a profitable marketing strategy taking things like CAC, LTV, Payback period, and P&L into consideration," explains LiveFlow co-founder, Lasse Kalkar .
When it came to including marketing strategy in its business plan, LiveFlow created a separate marketing profit and loss statement (P&L) to track how well the company was doing with its marketing initiatives.
This is a great approach, allowing businesses to focus on where their marketing dollars are making the most impact. Having this information handy will enable you to build out your business plan’s marketing section with confidence. LiveFlow has shared the template here . You can test it for yourself.
2. Lula Body

Sometimes all you need is a solid mission statement and core values to guide you on how to go about everything. You do this by creating a business plan revolving around how to fulfill your statement best.
For example, Patagonia is an eco-friendly company, so their plan discusses how to make the best environmentally friendly products without causing harm.
A good mission statement  should not only resonate with consumers but should also serve as a core value compass for employees as well.
Patagonia has one of the most compelling mission statements I’ve seen:
"Together, let’s prioritise purpose over profit and protect this wondrous planet, our only home."
It reels you in from the start, and the environmentally friendly theme continues throughout the rest of the statement.
This mission goes on to explain that they are out to "Build the best product, cause no unnecessary harm, and use business to protect nature."
Their mission statement is compelling and detailed, with each section outlining how they will accomplish their goal.
4. Vesta Home Automation

This executive summary for a smart home device startup is part of a business plan created by students at Mount Royal University .
While it lacks some of the sleek visuals of the templates above, its executive summary does a great job of demonstrating how invested they are in the business.
Right away, they mention they’ve invested $200,000 into the company already, which shows investors they have skin in the game and aren’t just looking for someone else to foot the bill.
This is the kind of business plan you need when applying for business funds. It clearly illustrates the expected future of the company and how the business has been coming along over the years.
5. NALB Creative Center

This fictional business plan for an art supply store includes everything one might need in a business plan: an executive summary, a company summary, a list of services, a market analysis summary, and more.
One of its most notable sections is its market analysis summary, which includes an overview of the population growth in the business’ target geographical area, as well as a breakdown of the types of potential customers they expect to welcome at the store. 
This sort of granular insight is essential for understanding and communicating your business’s growth potential. Plus, it lays a strong foundation for creating relevant and useful buyer personas .
It’s essential to keep this information up-to-date as your market and target buyer changes. For that reason, you should carry out market research as often as possible to ensure that you’re targeting the correct audience and sharing accurate information with your investors.
Due to its comprehensiveness, it’s an excellent example to follow if you’re opening a brick-and-mortar store and need to get external funding to start your business .
6. Curriculum Companion Suites (CSS)

If you’re looking for a SaaS business plan example, look no further than this business plan for a fictional educational software company called Curriculum Companion Suites. 
Like the business plan for the NALB Creative Center, it includes plenty of information for prospective investors and other key stakeholders in the business.
One of the most notable features of this business plan is the executive summary, which includes an overview of the product, market, and mission.
The first two are essential for software companies because the product offering is so often at the forefront of the company’s strategy. Without that information being immediately available to investors and executives, then you risk writing an unfocused business plan.
It’s essential to front-load your company’s mission if it explains your "Why?" and this example does just that. In other words, why do you do what you do, and why should stakeholders care? This is an important section to include if you feel that your mission will drive interest in the business and its offerings.
7. Culina Sample Business Plan

Culina's sample business plan is an excellent example of how to lay out your business plan so that it flows naturally, engages readers, and provides the critical information investors and stakeholders need. 
You can use this template as a guide while you're gathering important information for your own business plan. You'll have a better understanding of the data and research you need to do since Culina’s plan outlines these details so flawlessly for inspiration.
8. Plum Sample Business Plan

Don't forget to share this post!
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2 Essential Templates For Starting Your Business
Marketing software that helps you drive revenue, save time and resources, and measure and optimize your investments — all on one easy-to-use platform

Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.

Need more help?
Want more options.
Explore subscription benefits, browse training courses, learn how to secure your device, and more.

Microsoft 365 subscription benefits

Microsoft 365 training

Microsoft security

Accessibility center
Communities help you ask and answer questions, give feedback, and hear from experts with rich knowledge.

Ask the Microsoft Community

Microsoft Tech Community

Windows Insiders
Microsoft 365 Insiders
Was this information helpful?
Thank you for your feedback.
Financial Planning Business Plan
Ready to start your financial planning business? Set yourself up for success by creating a solid business plan. Download this business plan template, with pre-filled examples, to inspire your own plan.
Download a free financial planning business plan template in PDF or Word doc format
This form will load shortly, thanks for your patience.

What you'll get with this template:
	A complete business plan Unlike other blank templates, our business plan examples are complete business plans with all of the text and financial forecasts already filled out. Edit the text to make the plan your own and save hundreds of hours.
	A professional business plan template All 550 of our business plans are in the SBA-approved format that's proven to raise money from lenders and investors.
	Instructions and help at every step Get help with clear, simple instructions for each section of the business plan. No business experience necessary.
	A Word doc you can edit We don't just have PDF documents that make editing a challenge. Each plan is available in Word format so you can start editing your business plan example right away.

Key sections in this financial planning business plan:
All of our sample business plans are complete and include all of the sections that bankers and investors expect to see. Every plan includes the following sections:
	Executive Summary : A quick overview of your plan and entices investors to read more of your plan.
	Company : Describes the ownership and history of your business.
	Products and Services : Reviews what you sell and what you're offering your customers.
	Market Analysis : Describes your customers and the size of your target market.
	Strategy and Implementation : Provides the details of how you plan on building the business.
	Management Team : An overview of the people behind the business and why they're the right team to make the business a success.
	Financial Plan : A complete set of forecasts including a Profit and Loss Statement, Cash Flow Statement, and Balance Sheet.

If you're interested in learning how to write a business plan, read our free in-depth guide to writing a business plan , download our free Business Plan Template , and check out LivePlan —our award-winning business planning software.
Looking for a sample business plan PDF? You can download a few PDF examples below:
	Accounting and Bookkeeping Sample Business Plan PDF
	Agriculture Farm Sample Business Plan PDF
	Cleaning Service Sample Business Plan PDF


Need a faster way to write your business plan? LivePlan is the #1 planning tool for over 1 million businesses.

Discover the world’s #1 plan building software
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	Free PDF Business Plan Templates
Strategic planning Free PDF Business Plan Templates and Samples Get free Smartsheet templates By Joe Weller | September 9, 2020 We've gathered the most useful collection of business plan PDF templates and samples, including options for organizations of any size and type.




	PDF Example Business Plan
the Business it is agreed that the Recipient undertakes to the Business to treat as confidential the Business Plan and all information in any medium or format (whether marked "confidential" or not) whether in writing or oral which the Recipient receives during the relationship from the Business ( Confidential Information ). 2. The Recipient ...




	Download Free Business Plan Examples
You can download a few PDF examples below: Accounting and Bookkeeping Sample Business Plan PDF Agriculture Farm Sample Business Plan PDF Cleaning Service Sample Business Plan PDF Need a faster way to write your business plan? LivePlan is the #1 planning tool for over 1 million businesses.




	PDF BUSINESS PLAN
Here are some examples of our offerings: (insert images below) Currently, we use the following suppliers/vendors: ... Below is the timeline we anticipate to complete key activities: CONFIDENTIAL Page 10 7. FINANCIAL PLAN AND STATEMENTS ... BUSINESS PLAN TEMPLATE DISCLAIMER Any articles, templates, or information provided by Smartsheet on the ...




	PDF HOW TO WRITE A BUSINESS PLAN
What do I want from my customer? Equity, loan (secured or unsecured), expertise or advice? The business plan is your sales tool. Make sure that you know what you are using this tool for and take time to develop it. The Business Plan Framework Your plan should encompass the following issues:




	Free Simple Business Plan Templates
Download Basic Business Plan Sample. Word | PDF. This business plan sample serves as an example of a basic business plan that contains all the traditional components. The sample provides a model of what a business plan might look like for a fictional food truck business. Reference this sample as you develop your own business plan.




	Write your business plan
Executive summary Briefly tell your reader what your company is and why it will be successful. Include your mission statement, your product or service, and basic information about your company's leadership team, employees, and location. You should also include financial information and high-level growth plans if you plan to ask for financing.




	550+ Sample Business Plan Examples to Inspire Your Own
550+ Business Plan Examples to Launch Your Business Need help writing your business plan? Explore over 550 industry-specific business plan examples for inspiration. Go even further with LivePlan, which harnesses AI-assisted writing features and SBA-approved plan examples to get you funded. Find your business plan example




	How to Write a Business Plan: Guide + Examples
Most business plans also include financial forecasts for the future. These set sales goals, budget for expenses, and predict profits and cash flow. A good business plan is much more than just a document that you write once and forget about. It's also a guide that helps you outline and achieve your goals. After completing your plan, you can ...




	6 Free Business Plans
6 Free Business Plans | PDF Templates & Examples Download free templates Featured business templates Agendas & Schedules Weekly Schedule Template Tracking employees' work time and wages is easy with this free weekly schedule template. Download template Learn more Dashboards & Reports Monthly Report




	Business Plan Template in PDF
Use our downloadable free business plan template PDF to outline your company's goals and milestones, including how to structure, run, and grow your new business. Bring on investors or new business partners Use your powerful business plan to get funding or bring on new business partners.




	Business Plan Templates: 26 FREE Samples
Operations plan. Management organization. Financial plan. Conclusion & appendix. Every section involved in a business plan is designed to help startup businesses reach their target market. A business plan asks founders and entrepreneurs to detail their business strategy in a step-by-step process that makes sense from an operational perspective.




	PDF Business Plan Guide for pdf
The examples are very short and concise. They are only intended to show you one standard type format. Your business plan should be much more specific and extensive and should present your ideals, perceptions and goals. Note: Your first attempt to put together a business plan will probably not be the last.




	14 Business Plan Examples & Samples to Write Your Own [2024]
1. E-commerce Plan Sample or Example 2. Online Marketplace Business Plan Example or Sample 3. Snack Bar Business Plan Sample / Business Plan Example 4. Coffee Shop Business Plan Sample/Business Plan Example PDF




	Business Plan Example and Template
Business Plan Example and Template Learn how to create a business plan Over 1.8 million professionals use CFI to learn accounting, financial analysis, modeling and more. Start with a free account to explore 20+ always-free courses and hundreds of finance templates and cheat sheets. Start Free Written by CFI Team What is a Business Plan?




	Free editable and printable business plan templates
Document by Ubara. Startup Business Plan in Cream Black and White Modern Sophisticated Style. Document by Canva Creative Studio. Green and White Modern Business Plan Cover Page. Document by Magic Power. Orange Grey Professional Business Plan Cover. Document by Ubara. Brown and White Modern Restaurant Business Plan Document. Document by Morp.




	PDF Business Plan for a Startup or Existing Business
A business plan consists of a narrative description and financial projections. The narrative description is the body of the business plan. The sections of a business plan can be completed in any order you wish, except for the Executive Summary, which should be completed last but placed at the front of the document.




	PDF BUSINESS PLAN
Develop realistic but aggressive projections, explain use of fund and expected payback period. Complete all the sections of a business plan first, then put all the highlights in the Executive Summary concisely. Review and edit before presenting it. Tips to write a Business Plan. Tailor your business plan to suit different readers.




	PDF Helping Maine'S Small Businesses Succeed Since 1977
WRITING A BUSINESS PLAN . Introduction . Writing a business plan is an important step in starting or expanding any business. It assists the business owner by organizing information that describes the business and its operation. As such, it becomes a guide for creating strategic plans to develop a business or to better manage an existing business.




	Simple Business Plan Template (2024)
This section of your simple business plan template explores how to structure and operate your business. Details include the type of business organization your startup will take, roles and ...




	24 of My Favorite Sample Business Plans & Examples For Your Inspiration
8. Panda Doc's Free Business Plan Template. PandaDoc's free business plan template is one of the more detailed and fleshed-out sample business plans on this list. It describes what you should include in each section, so you don't have to come up with everything from scratch.




	PDF Business Plan Basics
This business plan is a generic model suitable for all types of businesses. However, you should modify it to suit your particular circumstances. Executive Summary (1 page) Write this section last. Include everything that you would cover in a five-minute interview. Make it enthusiastic, professional, complete, and concise.




	Create a form in Word that users can complete or print
Show the Developer tab. If the developer tab isn't displayed in the ribbon, see Show the Developer tab.. Open a template or use a blank document. To create a form in Word that others can fill out, start with a template or document and add content controls.




	Financial Planning Business Plan Template
You can download a few PDF examples below: Accounting and Bookkeeping Sample Business Plan PDF Agriculture Farm Sample Business Plan PDF Cleaning Service Sample Business Plan PDF Need a faster way to write your business plan? LivePlan is the #1 planning tool for over 1 million businesses.
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